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1 Introduction 
 
The Preventing Plastic Pollution project has chosen to work on the scale of 7 
catchment areas, in order to better understand plastic pollution and its origins 
and to compare all the actions carried out and their impacts by involving all the 
stakeholders in the catchment areas.  
 
All these actions in partnership with 18 organizations from France and England 
aim to understand and reduce the impacts of plastic pollution, macroplastics and 
microplastics. 
 
It is important to understand the origin of plastics at sea in order to effectively 
target the sources that release them. Generally, there is little information on the 
extent of plastic pollution and where it originates, making management of the 
problem fragmented, costly and difficult.  
 
The project has worked in 7 pilot catchments that represent different conditions 
of activity in the France-Channel-England area: the Bay of Brest, the Bay of Veys, 
the Bay of Douarnenez (Figure 1), Medway, Tamar, Great Ouse and Poole Harbour 
(Figure 2). The pilot areas will be used to prove the effectiveness of a transferable 
zonal approach to plastic pollution. 

 
Figure 1 : the three French study basins of the PPP project 
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Figure 2 : the four English study basins of the PPP project 

In order to have a comparative approach in these 7 pilot catchments of the 
project, it was decided to work jointly on a harmonization of the methods of 
measurement and identification of plastic pollution. 
 
In this guide to standardized approaches to model the transport of microplastics 
from source to sea, the methods used in 4 of the study catchments are 
presented: the Bay of Brest, the Bay of Douarnenez and the Bay of Veys in France 
and the Tamar catchment in England. The first part explains the application of 
the SWAT model for the modelling of microplastic flows in rivers in order to 
highlight the source points and accumulation areas of microplastics. The second 
part describes the approach developed to model plastic pollution at sea, with the 
aim of identifying possible pollution concentration points in the maritime 
domain, and to identify the sources that contribute most to pollution at sea. 
 
Other aspects of the standardization of measurements are presented in the other 
project deliverables: 
 The macroplastics database, which collects all data from macroplastics 

collections in the watersheds, the shoreline, and the coastal zone of the 
pilot areas. Available on: 
https://data.preventingplasticpollution.com/pages/about (To access the 
information in French, use the "translate" icon on the left of the page). 

 The microplastics database, which collects the results of the project 
 Standardized approach to measure and identify plastic pollution  
 Dispersion models at sea. Available on 

:https://ppp.actimar.fr/ppp/presentation 
 

In the project, Work Package T1 "Understanding Plastic Pollution - From Source to 
Sea" also focused on the impacts of microplastics in freshwater and marine 
environments  
  

https://data.preventingplasticpollution.com/pages/about
https://ppp.actimar.fr/ppp/presentation
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2 Introduction to the SWAT mode 
 

The SWAT model, for "Soil and Water Assessment Tool", is a semi-distributed 
agro-hydrological model developed in the 1990s by researchers at the United 
States Department of Agriculture. It allows to model surface and subsurface 
runoff in a watershed, while taking into account its physical characteristics: 
climate, pedology, slope, land use...  

 
Mainly used in the agricultural domain to predict the effects of land management 
on water resources, it can also be used to model sediment and nutrient 
transport, to model pesticide or other pollutant transfer flows, or to evaluate the 
impact of soil artificialisation on water resources. 

 
In order to model the flows from the source to the outlet, it is necessary to 
reproduce the water cycle in the watershed in a simplified way. The water 
balance controls the different hydrological processes that take place in the basin. 
In the case of SWAT, the following hydrological equation is used: 

𝑆𝑊𝑡 = 𝑆𝑊𝑂 + ∑( 𝑅𝑑𝑎𝑦 − 𝑄𝑠𝑢𝑟𝑓 −  𝐸𝑎 −  𝑊𝑠𝑒𝑒𝑝 −  𝑄𝑔𝑤) 

 
With :  

SWt : soil water content (mm) 
SWo : water available for plants (mm) 
Rday : precipitation (mm) 
Qsurf : surface runoff (mm) 
Ea : evapotranspiration (mm) 
Wseep : percolation (mm) 
Qgw : low water flow (mm)  
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The variables involved in this equation that make up the water cycle are 
infiltration, evapotranspiration, plant removal, lateral and vertical flow (Figure 3). 
Many methods are available to calculate each of these variables. For our study, 
the Penman/Monteith equation, using climate data was chosen.  

2.1 SWAT software versions and installation 
 

To facilitate the use of input data for modeling, SWAT can be added as an 
extension of a Geographic Information System (GIS) software. QGIS is a freely 
downloadable GIS software with sufficient options to use SWAT. The most recent 
and stable versions are QGIS 3.16 and 3.22 
(https://qgis.org/fr/site/forusers/download.html, tab "All versions"). ArcGIS can 
also be used with version 10.8 or earlier. 
 

There are three versions of SWAT compatible with QGIS: QSWAT3, 
QSWAT3_64, QSWAT3_9, downloadable at 
https://swat.tamu.edu/software/plus/. Details about which version is 
compatible with your computer are given there. There are many versions of 
ArcSWAT from ArcGIS 10.0 onwards. The different versions can be downloaded 
under the link: https://swat.tamu.edu/software/arcswat/. 

 
2.2 Installation of complementary software to QSWAT and ArcSWAT 

 
The advanced steps of the hydrological simulation of the model are done on 

complementary software to QSWAT and ArcSWAT, freely available: 
 

- SWAT Editor is used to integrate weather data, edit parameters and 
launch the model: https://swat.tamu.edu/software/swat-editor/   
 
 

Figure 3 : simplified representation of the water balance of the 
SWAT model 

https://qgis.org/fr/site/forusers/download.html
https://swat.tamu.edu/software/plus/
https://swat.tamu.edu/software/arcswat/
https://swat.tamu.edu/software/swat-editor/
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- SWAT-CUP is used for sensitivity analysis, calibration and model 
validation: https://swat.tamu.edu/software/swat-cup/  - choose 
"Download SWAT-CUP 5.1.6.2” 
 
 

- Microsoft Acces is used to edit .mdb databases 
 

 
2.3 Steps in hydrological modeling with SWAT 

 
In order to model a microplastics flow in a watershed - for which data were 
collected according to the methods described in Deliverable T1.1.2. - it is first 
necessary to know the water flow in the river concerned. In order to obtain a flow 
model that is as close to reality as possible, the model must be compared and 
calibrated against observed flows. These real flows can for example come from 
hydrometric stations with daily readings. The SWAT software allows to model and 
parameterize the flows at these points of interest. The modeling steps are 
described below and represented in the diagram in Figure 4. The choice was made 
to model daily flows. 
 

1. Acquisition of topographic, pedological, land use, climatological and 
hydrological data 
Several sources of access to these data exist. These sources can be more or 
less complete and precise, some are free, others are not.  In this guide we 
detail the most easily accessible and reliable data sources. 
 

2. The implementation of the model 
a) The delineation of subbasins 

In this first step under QGIS or ArcSWAT, SWAT defines the watershed 
network according to the topography and the given outlet point. For this, a 
digital elevationmodel (DEM) is used. This also allows the delineation of 
subbasins. 

 
b) The definition of Hydrological Response Units (HRU) 

A HRU is the unique combination of a soil type, land use type, and slope 
class. SWAT model calculations are performed for each of these HRUs and 
then assembled to obtain a flow at the outlet. This step involves filling in the 
soil and land use data for the entire study area. 
 

c) Integration of meteorological data 
Daily and monthly average climate data (rainfall, minimum and maximum 
temperatures, wind speed, relative humidity and solar radiation) are 
integrated into SWAT Editor for the desired modeling period. In addition to 
the desired simulation duration - from 2020 to 2022 for PPP - data from a 
period of at least three years prior to the start of the simulation are required. 
This is the time of a complete groundwater recharge, called the warm-up 
period. It is not taken into account in the simulation results. 

  
The geographical location of the weather stations is also entered, so SWAT 
automatically selects the data from the station closest to the HRU. 
 

https://swat.tamu.edu/software/swat-cup/
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d) Adjustment of input data 
The calculation methods of the water cycle mechanisms 
(evapotranspiration, runoff...) are defined at this stage. 
 
As the SWAT model is American, the data on agricultural practices and land 
use may be different from European practices. In case we have access to 
this knowledge for the concerned study area, it is possible to adjust these 
parameters in SWAT Editor. All other known data that can be taken into 
account in the hydrological process of the study area can be integrated in 
this step, otherwise default values are applied. 
 
Microplastics (MP) data will also be integrated in this step. It is not possible 
to enter MP concentrations directly into SWAT, but MP transport can be 
assimilated to sediment transport. Indeed, MP can be transported in the 
river, settle on the bottom or on the edges, in the same way as sediments. 
Each sampling point is then considered as a source point of sediment flux 
where MP data are integrated. 
 

3. The simulation  
At the model launch stage, the simulation period is defined, the choice of 
output files is made (daily, monthly, annual and/or average output data), the 
warm-up period (NYSKIP) is set. 

 
4. Sensitivity analysis 

This step consists of highlighting the sensitive parameters that most 
influence the hydrological processes of the study catchment area and thus 
the model results. By performing an analytical review of the input 
parameters, this step helps to limit the number of parameters to be 
calibrated and helps in the validation of the model. In SWAT-CUP, the 
sensitivity analysis consists in very slightly varying some of the input 
parameters to observe the output simulation variations. 
 

5. Calibration of the model 
Once the most sensitive parameters have been determined, the SWAT-CUP 
software launches an auto-calibration: the model runs on a very large 
number of simulations in order to adjust the simultaneous values of these 
parameters in order to obtain a flow simulation that is as close as possible 
to the observed values (at a hydrometric station for example). A good model 
is characterized by the following correlation coefficient values:  
 

Coefficient Abbreviation Range Valeur to 
reach 

Pearson coefficient of 
determination R² [0 ; 1] ≥ 0.6 

Nash-Sutcliffe efficiency NSE ou NS [- ∞ ; 1] ≥ 0.6 
R² multiplied by the regression 
line between simulated and 
measured data 

Br² [0 ; 1 ] ≥ 0.6 

Percent bias PBIAS  [0 ; + 
∞ ] Tends to 0 

 



 
Transferable Catchment Model 

11 
 

 
6. Model validation 
Finally, the validation step consists of applying the adjusted parameters to the 
other streams in the study area. If the correlation coefficients are close to the 
desired values, the model is validated and reliable. 
It is then possible to extract the output data in the form of a spreadsheet that 
can then be reprocessed into graphs, tables, maps, etc.



 
Transferable Catchment Model 

12 
 

 
Figure 4 : SWAT model construction on the different SWAT interfaces 
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3 Data acquisition for QSWAT and ArcSWAT models 
 
The input data should be saved in the same folder 'InputData' in a working file 
which will also contain the modeling results. Preferably work under the local disk. 
Example: C:/.../modeling/InputData. 
 
The ‘InputData’ folder will contain 7 subfolders : 

- DEM 
- Streams 
- MainOutlets 
- ObservedFlow 
- Landuse 
- Soils 
- Climate 

 
The QSWATRef2012 database (under C:\SWAT\SWATEditor\Databasesest) for 
QGIS and SWAT2012 (under C:\SWAT\SWAT2012) are the databases from which 
SWAT relies to read the input data. The reference data contained in the database 
are taken from the American information systems, especially for the soil data 
(spreadsheets “soils” and “usersoils”) and the weather generator (spreadsheet 
“WGEN_user”). It will be possible to modify them directly in the database. 
 
The different data sources needed to run the SWAT model are shown in Table 1. 
The sources depend on the location of the study watershed. 
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Table 1 : list of data sources needed for the SWAT model 

Data type France UK Worlwide 
Help / 

Tutorial 

DEM 

- Géoservices : BD ALTI (25 m) 
- Géoservices : RGE ALTI (1-5 m) 
- SIG/mapping service of the 
concerned department (ex : 
CG50, CD14) 

UK Ordnance Survey : OS Terrain 
50 (50m) 

SRTM (Shuttle Radar 
Tomography Mission) 
- 90 m 
- 30 m 

Manual 

Hydrography Geo.data.gouv.fr 

UK Ordnance Survey : OS Open 
Rivers 

    

Outlets and observed flows Eau France : HydroPortail National River Flow Archive      

Landuse Data.gouv.fr : Corine Land Cover 

Environmental Information Data 
Center 

ESA : data user element 

Manual 
Video 

Soils 
- Map Agroenvgeo (INRA) National Soil Resources Institutes FAO : Digital Soil Map of the 

World 

Manual 
Video  

- Usersoils data   National Soil Map  

Climate data 

- Daily 
Météo France 
→ create an account 
→ not free of charge 

CEDA Archive : Met Office station 
network 
→ under government license ArcSWAT 2012 Global 

Weather Data 

Manual 
Video 

- Monthly 
Météo France – « Sélection et 
téléchargement » section 
Liste des stations 

- UK Meteorological Service 
- CEDA Archive : Met Office 
"HadUK-Grid" 

Crop data Data.gouv.fr : RPG 
Data.gouv.uk : Crop Map of 
England 

  

 
 

https://geoservices.ign.fr/bdalti
https://geoservices.ign.fr/rgealti
https://manchenumerique.fr/
https://transfert.calvados.fr/
https://www.ordnancesurvey.co.uk/business-government/products/terrain-50
https://www.ordnancesurvey.co.uk/business-government/products/terrain-50
https://srtm.csi.cgiar.org/
http://earthexplorer.usgs.gov/
https://swat.tamu.edu/media/114677/dem-preparationv2.pdf
https://geo.data.gouv.fr/fr/datasets/ee5c709c9b7ff928ab2529b79ce6e879c4de6950
https://beta.ordnancesurvey.co.uk/products/os-open-rivers
https://beta.ordnancesurvey.co.uk/products/os-open-rivers
https://www.hydro.eaufrance.fr/rechercher/entites-hydrometriques
https://nrfa.ceh.ac.uk/data/search
https://www.data.gov.uk/dataset/be5d88c9-acfb-4052-bf6b-ee9a416cfe60/crop-map-of-england-crome-2020
https://catalogue.ceh.ac.uk/documents/084e0bc6-e67f-4dad-9de6-0c698f60e34d
https://catalogue.ceh.ac.uk/documents/084e0bc6-e67f-4dad-9de6-0c698f60e34d
http://due.esrin.esa.int/page_globcover.php
https://swat.tamu.edu/media/114679/globaldatav1.pdf
https://www.youtube.com/watch?v=hXf7P0oaYMM
https://agroenvgeo.data.inra.fr/geonetwork/srv/fre/catalog.search#/metadata/d95caa37-436b-431c-9391-643164f010bb
https://www.cranfield.ac.uk/centres/centre-for-soil-agrifood-and-biosciences/research-groups/national-soil-resources-institute
https://data.apps.fao.org/map/catalog/srv/eng/catalog.search#/metadata/446ed430-8383-11db-b9b2-000d939bc5d8
https://data.apps.fao.org/map/catalog/srv/eng/catalog.search#/metadata/446ed430-8383-11db-b9b2-000d939bc5d8
https://swat.tamu.edu/media/114679/globaldatav1.pdf
https://www.youtube.com/watch?v=FDF6bqhaRXc
https://www.landis.org.uk/data/natmap.cfm
https://donneespubliques.meteofrance.fr/?fond=caracteristique&caracteristique=11&caracdisp=28
https://catalogue.ceda.ac.uk/uuid/dbd451271eb04662beade68da43546e1
https://catalogue.ceda.ac.uk/uuid/dbd451271eb04662beade68da43546e1
https://swat.tamu.edu/data/
https://swat.tamu.edu/data/
https://swat.tamu.edu/media/99083/arcswat_globalweatherdatabase.pdf
https://www.youtube.com/watch?v=yj4CsagMRtw
https://donneespubliques.meteofrance.fr/?fond=produit&id_produit=117&id_rubrique=39
https://donneespubliques.meteofrance.fr/client/document/listeparametrescompletes_239.html
https://www.metoffice.gov.uk/
https://www.metoffice.gov.uk/research/climate/maps-and-data/data/haduk-grid/datasets
https://www.metoffice.gov.uk/research/climate/maps-and-data/data/haduk-grid/datasets
https://www.data.gouv.fr/fr/datasets/registre-parcellaire-graphique-rpg-contours-des-parcelles-et-ilots-culturaux-et-leur-groupe-de-cultures-majoritaire/
https://www.data.gov.uk/dataset/be5d88c9-acfb-4052-bf6b-ee9a416cfe60/crop-map-of-england-crome-2020
https://www.data.gov.uk/dataset/be5d88c9-acfb-4052-bf6b-ee9a416cfe60/crop-map-of-england-crome-2020
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3.1 Preparation of topographic data: the DEM 
 

A DEM or Digital Elevation Model is a topographic representation of a land 
area created from elevation data of the ground, in raster format. It allows the SWAT 
software to know the slope of the catchment area. 
 

Due to the large size of these types of files, DEM data are downloaded as tiles, 
and can be downloaded via FilleZilla (https://filezilla-project.org/). They can be 
merged in ArcGIS or QGIS (Raster > Divers > Merge) to provide coverage of the area 
of interest. 
 
The layer must be under the same Coordinate Reference System (CRS) as the 
project and all other layers imported into the project. 

- For catchments located in France, choose EPSG:2154 (RGF93 v1/Lambert-
93) 

- For catchments located in England, choose EPSG:27700 (OSGB36 / British 
National Grid - United Kingdom Ordnance Survey) 

 
Save the DEM in raster .tif format under C:/.../modelization/InputData/DEM. 
 

3.2 Obtaining the stream network 
 

To guide the model towards a representation of the reality, it is interesting to 
provide the stream network, in a vector format. 
 

The stream network layer is often obtained at a larger scale than the 
watershed. On the French territory, it is possible to download only a part of the 
network, either by catchment area (examples: "CoursEau_03_Seine-
Normandie.shp", "CoursEau_04_Loire-Bretagne.shp"), or by region (examples: 
"CoursEau_28_Normandie.shp" or "CoursEau_53_Bretagne.shp"). In England, we 
obtain an ESRI shp layer for the whole country. 

 
To make the stream network cover the study area, use the function 

Geoprocessing tools > Clip... on QGIS and ArcGIS. 
 
Check that the layer is in the desired projection (§3.1). 
Save the layer in shp format under C:/.../modeling/InputData/Streams. 

 
3.3 Location of outlets and source points 

3.3.1 Outlet points for the calibration step 
 

To model a flow as accurately as possible, it must be compared to a real 
observed flow. Thus, the parameterization of the model will be obtained from flow 
data observed at hydrometric stations. Their location will represent the outlets, 
which will allow the precise calibration of the model. 

 
Method :  

 
1. From the data source indicated in Table 1, select the most interesting 

hydrometric stations, in terms of proximity to the sampling points and 

https://filezilla-project.org/
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whose values are the most complete for the study area and period. Locate 
the geographic coordinates of the stations in the station description. 
 

2. In a spreadsheet in csv format, enter the coordinates for each selected 
hydrometric station (Table 2) 

Table 2 : CSV file of the location of the hydrometric stations 

 
 
 

 
 
 

3. On QGIS, add the layer : Layers > Add layers > Add Delimited Text Layer. 
A wibdow opens :  

▪ In « File name », choose the coordinate csv file 
▪ Check ‘File Format’ = csv. 
▪ X field = Longitude 
▪ Y field = Latitude 
▪ Click on « Add » 

 
4. To save the layer, right click on the layer > Export > Save Feature As...  

A window opens. Choose : 
▪ Format = ESRI Shapefile 
▪ CRS = cf. §3.1 
▪ File Name = C:/…/modeling/InputData/MainOutlets/hydro-

stations.shp 
▪ « OK » 

 
3.3.2 Outlets and source points 
 

In order to validate the model and inform the sources of microplastic fluxes, 
it will be necessary to apply the calibrated hydrological parameters at the 
microplastic sampling points. A layer containing these points must therefore be 
created. 

 
Follow the same steps as in §3.3.1 and save the file under 

C:/.../modeling/InputData/MainOutlets/sample-points.shp 
 

3.4 Land Cover Data Formatting 
 

The land cover allows the model to identify areas that are more or less 
artificial, which provides information on their capacity for infiltration, runoff 
and/or evapotranspiration. SWAT requires as input files, a raster map with each 
pixel assigned to a land use type and an associated csv file. SWAT is able to read 
land cover codes based on FAO (Food and Agriculture Organization) data entered 
in the "crop" table of the QSWATRef2012 and SWAT2012 databases. 

 
3.4.1 Landuse map 
 

Station Longitude Latitude 
hydro-station-1 x.xxx y.yyy 
hydro-station-2 x.xxx’ y.yyy’ 
… … … 
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The land cover of the European territory is available via the Corine Land Cover 
inventory. The most recent version dates from 2018 and is available under the links 
in Table 1. 

 
Method :  

1. Get the CLC_2018 layer focused on the study area 
On QGIS or ArcGIS, in the section : Geoprocessing Tools > Clip.... 
Clip the CLC_2018 layer with the study area's extent. 
Save the new layer 'CLC_2018_clip' in shp format. 

 
2. Simplify the map by unifying entities with the same CLC code 

In the section : Geoprocessing Tools tab > Dissolve. Choose the field 
“dissolve field” = code_18 
Save the new layer 'CLC_2018_clip_dissolve' in shp format. 

 
3. Match the European land cover codes in the Corine Land Cover database 

to the US land cover codes compatible with QSWAT and ArcSWAT. 
▪ In the 'CLC_2018_clip_dissolve' layer attribute table, add a 

first column 'SWAT_CODE' and match the 'code_18' column 
from Table 3. 
 

▪ Other types of land use exist. Bibliographic research allows us 
to find the equivalences. 

 
Table 3 : correspondence of the Corine Land Cover 2018 land use codes with those of the SWAT 
database 

Code 
CLC 

Class CLC 
Level I 

Corine Land Cover Class 
Code 
SWAT 

SWAT Class 

111 

Artificialised 
territories 

Continuous urban fabric URHD Residential - high density 

112 Discontinuous urban fabric URML Residential - medium to low density 

121 Industrial and commercial units UCOM Commercial 

122 
Road and rail networks and associated 
land 

UTRN Transport 

123 Port areas UIDU Industrial 

124 Airports UIDU Industrial 

131 Mineral extraction sites SWRN Arid + Quarries and mines 

141 Green urban areas RNGE Grassland / Herbaceous 

142 Sport and leisure facilities UCOM Commercial 

211 

Agricultural 
territories 

Non-irrigated arable land AGRL Generic agricultural land 

212 Permanently irrigated land AGRL Generic agricultural land 

221 Vineyards GRAP Vineyards 

222 Fruit trees and berry plantations ORCD Orchard 

231 Pastures PAST Pasture/hay 

242 Complex cultivation patterns AGRL Generic agricultural land 

243 
Land principally occupied by 
agriculture, with significant areas 
of natural vegetation  

AGRL Generic agricultural land 

311 Forests Broad-leaved forest FRSD Deciduous forest 
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312 Coniferous forests FRSE Coniferous forest 

313 Mixed forests FRST Mixed forests 

321 Shrubby 
and/or 

herbaceous 
vegetation 

Natural grasslands RNGE Variety of grasses 

322 Moors and heathland RNGB Variety of bushes 

324 Transitional wooland-shrub RNGB Variety of bushes 

331 Open spaces 
with little or no 

vegetation 

Beaches, dunes, sands BARR Barren 

332 Bare rocks BARR Barren 

333 Sparsely vegetated areas BSVG Scattered vegetation 

411 

Wetlands 
 

Inland marshes WETN Wetland, non-forested 

412 Peat bogs WETN Wetland, non-forested 

421 Salt marshes WETL Wetland, mixed 

423 Intertidal flats WETL Wetland, mixed 

511 

Water surfaces 

Water courses WATR Water 

521 Coastal lagoons WATR Water 

522 Estuaries WATR Water 

523 Sea and ocean WATR Water 

 
4. Link the map attribute table to the search table (§3.4.2) 

Add a second column 'LANDUSE_ID' by assigning a unique number to 
each entity. The attribute table must have at least 2 columns: 
'LANDUSE_ID' and 'SWAT_CODE' (Figure 5). The area of each land use 
type (area_ha) is interesting to indicate. 

 

Figure 5 : Screen shot of an example of an attribute table to be obtained for the land cover layer 

 
5. Rasterize the layer from shp format to tif format 

In the section : View > Panels > Processing Toolbox, choose 'Rasterize 
(vector to raster)' and specify : 

▪ Field to use for a burn-in value = LANDUSE_ID 
▪ Output extent = calculate from layer 
▪ Nodata value to output bands = -999 

 
Check that the CRS of the layer is in the desired format (§3.1). 
Save the layer in tif format under C:/.../modeling/InputData/Landuse. 

 
3.4.2 Landuse lookup table 
 

1. In a spreadsheet, create two columns (Table 4): 
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1. Column name 1: 'LANDUSE_ID'. Per row: each identity number 
assigned in step 3 of §3.4.1. 

2. Name column 2: 'SWAT_CODE'. Per row: each land use type 
name assigned in step 3 of §3.4.1. 
 

2. Save in csv format under C:/... /modeling/InputData/Land Use. The title of 
the file must contain the term 'landuse'. 
 

 
 

Table 4 : example of a land use search table, in csv format 

LANDUSE_ID SWAT_CODE 
1 UCOM 
2 WETN 
3 RNGE 
… … 

 
3.5 Acquisition of soil data 

 
The soil data will allow the SWAT software to estimate the amount of water 

that can infiltrate more or less deeply into the soil or run off, depending on the 
type of soil over the watershed. Several sources and methods exist to obtain a soil 
layer suitable for QSWAT. 

 
SWAT requires as input files, a raster file with each pixel assigned to a soil 

type and two associated spreadsheets: "soils" and "usersoils". SWAT is able to read 
land cover codes based on data from the FAO (Food and Agriculture Organization) 
(see methods §3.5.1 and §3.5.3). It is also possible to integrate one's own soil data 
system by modifying the SWAT input databases in Microsoft Access or equivalent 
(see method §3.5.2). 

 
Soil data are stored under C:/.../modeling/InputData/Soils. 

 
3.5.1 Worldwide data : from the US DSMW database 
 

o Advantages: free, data already in the right format 
o Disadvantage: not very accurate for territories outside the US 

 
Method : 

1. On QGIS/ArcGIS, clip (“Clip…” function) the DSMW layer with the study area 
and save the layer as 'soils_DSMW_clip.shp’ 

2. In the attribute table, the 'FAO_code' column corresponds to the SWAT-
compatible codes that will be found in the 'global_soils' and 'usersoils' link 
files. 

3. Dissolve ("Dissolve" function) then rasterize ("Rasterize" function) by 
choosing: "Field to use for a burn-in value" = FAO_CODE. 

4. Check that the layer is in the right projection (§3.1) and save the layer 
'soils_DSMW_clip' in tif format under C:/.../modeling/InputData/Soils. 
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3.5.2 In England: using a different data system from SWAT 
 

o Advantages: free and accurate local information 
o Disadvantages: requires the creation of a search table and the 

modification of the input QSWATRef2012/SWAT2012 database. 
 
Creation of the lookup table ('soils_lookup.csv'): 
It includes two columns:  

- 'SOIL_ID' : unique soil type identifier 
- SNAM' : soil type name 

 
 
 
Creation of a spreadsheet 'usersoils' : 
It contains the soil characteristics information for each layer of each identified soil 
type. It will be integrated into the QSWATRef2012/SWAT2012 database. 
 
The first four columns identify the soil types: 
 

CODE Description   

SEQN Unique soil type identifier ➔  
refers to the 'SOIL_ID' 
of the file 
soils_lookup.csv 

SNAM Soil type name ➔ 
refers to the 'SNAM' of 
the file 
soils_lookup.csv 

NLAYERS Number of soil layer   

SOL_ZMX 
Maximum rooting depth of soil profile 
(mm) 

  

 
For each soil type, the following columns describe each layer that constitutes it: 
 

CODE Description  

SOL_Z1 
Depth of the soil surface of the layer 
(mm) 

 
 
    The '1' refers to the first soil 
layer; there are as many 
parameters to be filled in for 
each layer accounted for in 
NLAYERS 

SOL_BD1 Wet bulk density (mg/m3 or g/cm3) 

SOL_AWC1 
Available water capacity of the soil layer 
(mm H2O/mm of soil) 

SOL_K1 Saturated hydraulic conductivity (mm/hr) 
SOL_CBN1 Organic carbon content (% of soil weight) 
CLAY1 Clay content (% of soil weight) 
SILT1 Silt content (% of soil weight) 
SAND1 Sand content (% of soil weight) 

ROCK1 
Rock fragment content (>2mm diameter) 
(% of soil weight) 

SOL_ALB1 Wet soil albedo 
USLE_K1 USLE soil erodibility factor (K) equation 

 
These informations (with the exception of soil albedo and K-factor) are available 
from the National Soil Map linked, via the NATMAP association file, to the three 
hydrological datasets SOILSERIES, fundamental HORIZON and hydraulic 
HORIZON. See http://www.landis.org.uk/data/index.html for more details on 
these data sources. 

http://www.landis.org.uk/data/index.html
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Using a relational database (Microsoft Access or equivalent), it is possible to link 
the three datasets, then compile the required data from the different datasets for 
each soil layer of each soil type of the watershed of interest and produce the file 
'usersoil.xls'. 
 
 
Integration of usersoils in QSWATRef2012/SWAT2012 
 
In Microsoft Access or equivalent:  
Rename the initial "usersoil" table to "usersoil_backup” 
Click on "External Data" > "New Data Source" > "From File" > "Excel” 
Choose the file "usersoil.xls" previously obtained. Name it "usersoil" 
 
3.5.3 In France: from INRA data (for QSWAT) 
 
INRA = Institut Nationale de la Recherche Agronomique (“National Institute of 
Agronomic Research ») 
 

o Advantages: free and accurate local information 
o Disadvantages: requires conversion to SWAT-compatible American 

format, whose information is not always easy to find. 
 

Method:  
1. Obtain the 'soils_inra' layer covering the study area 

On QGIS, clip the soils layer (obtained in Table 1) with the study area and 
save the 'soils_inra_clip.shp' layer (function : “Clip…”) 
 

 
2. Check the metadata in the attribute table 

In the attribute table, the soil types (column 'wrbdom') are described as 
'FLUVISOLS', 'CAMBRISOLS', 'REGOSOLS',... the literature informs us about 
the correspondences between the European and the American soil data 
system (cf. Tables 1 and 3 of FAO-Unesco (1981) available under the following 
link: https://www.fao.org/3/as354e/as354e.pdf).  Table 5 shows some of 
the correspondences that were necessary for the PPP project. 

 
Table 5 : examples of equivalences between the terminology of soils defined by INRA and those of 
FAO, according to FAO-Unesco, 1981. 

Soils 
referenced by 

the INRA 

Soil codes 
referenced by the 

FAO 
SOIL_ID 

SNAM 
(add the 'SOIL_ID' behind the FAO code to be 

read by QSWAT) 

ALBELUVISOLS Be142-2-3* 6455 Be142-2-3-6455 

FLUVISOLS Jc59-2-3a 6536 Jc59-2-3a-6536 

PODZOLS Po30-1ab 3239 Po30-1ab-3239 

LUVISOLS Lg51-2-3a 6564 Lg51-2-3a-6564 

HISTOSOLS Oe13-1a 6589 Oe13-1a-6589 

UMBRISOLS Jc59-2-3a* 6536 Jc59-2-3a-6536 

https://www.fao.org/3/as354e/as354e.pdf
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CAMBISOLS Be142-2-3 6455 Be142-2-3-6455 

ARENOSOLS Ql28-1b 6625 Ql28-1b-6625 

* For these types of soil, the bibliography does not allow us to know the exact equivalence. 
We have defined them according to the geographical disposition and the dominant soils 
around. 
 

3. Locate the nomenclature in the SWAT database 
In the local disk, under the path: C:\SWAT\SWATEditor\Databases, open 
QSWATRef2012.mdb then "usersoil". There is a column 'SNAM' which refers 
to the name of the types of ground readable by QSWAT and a column 
'SEQN' which refers to a unique identity number which will be used to make 
the connection with the card. 
 

 
4. Simplify the 'soils_inra_clip' layer 

On QGIS, dissolve the layer from the "wrbdom" attribute ("Dissolve" 
function). 
 

5. Link the attribute table of the map to the 'usersoil' table of QSWATRef2012. 
▪ In the attribute table, add two columns 'SNAM' (TEXT format) 

and 'SOIL_ID' (INTEGER format) 
 

▪ In 'SNAM', match the FAO codes to each Inra soil type in the 
'wrdbom' column. 

 
▪ In 'SOIL_ID', add for each 'SNAM' code the corresponding 

identity numbers of the 'usersoil' database 
 

▪ To be read by QSWAT, the 'SNAM' codes must be completed 
with the SOIL_ID numbers as in the 'SNAM' column of Table 5. 

 
▪ Finally, the attribute table must consist of at least two 

columns: 'SOIL_ID' and 'SNAM' (Figure 6). 
 

 
Figure 6 : Screen shot of an example of an attribute table to be obtained for the soil layer 

 
6. Rasterize (from vector to raster) 
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With the function 'Rasterize (vector to raster)', choose "Field to use for a 
burn-in value" = SOIL_ID. 
 

7. Save the file 
Check that the CRS of the layer is in the desired format (§3.1) and save the 
layer 'soils_FAO_clip' in tif format under C:/.../modeling/InputData/Soils.  
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3.6 Meteorological data acquisition 
 
The SWAT model requires the integration of several weather variables: 

▪ Precipitation (mm) – pcp 
▪ Maximum and minimum temperatures (°C) – tmp 
▪ Wind (m/s) – wind 
▪ Solar radiation (Mega Joules/m²) – solar 
▪ Humidity (%) - rh 

 
 

3.6.1 Daily data acquisition 
 
Method : 
 

1. From the links provided in Table 1, locate the nearest weather stations within 
or outside the study catchment area that have the most complete data 
available. Often there may be gaps in the data record at one weather station, 
so it is better to select several stations. 
 

2. Choose the period for which the data will be downloaded. At least, it must 
be the desired simulation period + the warm-up period. The warm-up period 
refers to the time necessary to simulate a complete aquifer recharge cycle 
before launching the simulation on the period of interest. A warm-up period 
of 3 years is sufficient. 

 
3. Order/download the data from the selected stations on the defined time 

step.  
 
 
Formatting of daily weather data: 

 
Under C:/…/modeling/InputData/Climate : 
 

1. Create a txt file for each parameter (pcp.txt, tmp.txt, wind.txt, solar.txt, 
rh.txt) specifying the longitude (x), latitude (y), elevation (z) of the weather 
stations that measure the selected parameters (sta1, sta2, ...). Each column 
is separated by a comma as in the example in Table 6. 

Tableau 6 : example of station file for pcp parameters, in txt format 

ID, NAME, LAT, LONG, 
ELEVATION 
1, pcp-sta1, x.xxx, y.yyy, z.zzz 
2, pcp-sta2, x.xxx’, y.yyy’, 
z.zzz’ 
3, pcp-sta3, x.xxx’’, y.yyy’’, 
z.zzz’’ 

 
2. Create a txt file for each parameter of each station where daily data are filled 

in, following the example in Table 7. Examples of file names: pcp-sta1.txt, 
tmp-sta3.txt, wind-sta2.txt, ... 
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 The first line of each file will contain the date of the first reading in 

the format YYYYMMDD (e.g. 20160101 for January 1, 2016) 
 Each daily value of the parameter and the station concerned is 

indicated per line 
 For tmp-stax.txt files, the max and min temperatures are entered 

on the same line, separated by a comma (Table 7). 
 More details under: 

https://swatplus.gitbook.io/docs/user/editor/inputs/climate > 
paragraph ‘SWAT2012/Global Weather Websites Format’  

 

Table 7 : example of daily maximum and minimum temperature file for the r tmp-sta1.txt 

20160101 
10.9, 5.4 
8.8, 4.2 
8.7, 4.0 
… 

 
 
3.6.2 Preparation of the monthly weather data 
 
Formatting monthly average weather data: 
 
Based on the data source in Table 1, report the monthly average values in a table 
following the "SWAT INPUT DATA: .wgn" manual: 
https://swat.tamu.edu/media/69335/ch12_input_wgn.pdf  

 
The first six columns describe the location of the weather stations and the next 168 
columns should show the average values for each month of: maximum 
temperature (TMPMX), minimum temperature (TMPMN), precipitation (PCPMM), 
solar radiation (SOLAR), wind speed (WNDAV). 
 
Missing data are replaced by "-99". 
Save the file WGEN_project.xls under C:/.../modeling/InputData/Climate. 
 
 
Integrate the table in the QSWATRef2012 or SWAT2012 database: 
 
In Access:  
Click on " External Data " > " New Data Source " > " From File " > " Excel ". 
Choose the file WGEN_projet.xls previously obtained. A new table appears in the 
database. 
 
3.6.3 In case of lack of local weather data 
 
The Table 1 shows a link to download daily and monthly weather data from around 
the world. This is a library containing the Climate Forecast System Reanalysis 
(CFSR) database, which can be read directly by SWAT. This meteorological 
database comes from satellite measurements. The parameters are estimated on 

https://swatplus.gitbook.io/docs/user/editor/inputs/climate
https://swat.tamu.edu/media/69335/ch12_input_wgn.pdf
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the whole planet earth, following a global grid. Although it saves time and money, 
these are estimates of meteorological parameters and their values may be less 
accurate than locally collected data. 
 

3.7 Formatting of daily flow data for model calibration 
 
3.7.1 Formatting of observed flows for SWAT-CUP 
 
Once the stations located in the area of 
interest have been identified, download the 
daily flow data in m3/s over a period that 
includes the desired simulation period + the 
warm-up period (see §3.6.1). 
 
 In a spreadsheet, the observed flow data 
must be presented in the form of Figure 7 so 
that it can be read by SWAT-CUP. The 
tutorial under the link 

https://www.youtube.com/watch?v=WeTMhfD1GUI helps to format this file. If 
there are days with missing data, assign them the value "-99". The observed flow 
data will be used as reference flows needed for the calibration step. 
 
3.7.2 Extrapolation of flows at sampling points 
 
In order to obtain the daily flows at the sampling points (Q'), it is necessary to 
extrapolate the flow from the closest measured flows (Q), by calculating the 
specific flows, with the following formula:  
 

𝑄′ =  
𝑄

𝑆
×  𝑆′ 

 
With : 

• Q = flow at the gauging point (m3/s) (m3/s) 
• Q’ = flow at the sampling point (m3/s) 
• S = Surface of the subbasin considering the outlet at the gauging point 
• S’ = Surface of the subbasin considering the outlet at the sampling point 

 
A spreadsheet is then obtained for each sampling point in the catchment area, 
with the "observed" daily flows extrapolated over the defined simulation period. 
 
Save each file of extrapolated observed flows in a table in the form of Figure 7. If 
there are days with missing data, assign a value of "-99" to them. 
 
These will be the observed flows that will be used in the validation and microplastic 
flux modeling steps.  

Figure 7 : screen shot of a daily observed 
flow data file 

https://www.youtube.com/watch?v=WeTMhfD1GUI%20
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4 Hydrological modeling with SWAT 
 
 
Once all the input data have been collected and formatted, the model can be set 
up. 
 
Several tutorials exist to assist in setting up the model: 

- https://www.youtube.com/watch?v=2YW0ZDNfdlU&t=711s 
- https://www.youtube.com/watch?v=9YQUO7EXTps 
- https://www.youtube.com/watch?v=xn9h_EHt6EY  
- https://swat.tamu.edu/media/116371/qswat-manual_v19.pdf 
- https://web.ics.purdue.edu/~vmerwade/education/qswat.pdf  
- https://swat.tamu.edu/workshops/instructional-videos/ 

 
WARNING before running SWAT :  
 

- set the computer to US format. Dates must be in mm/dd/yyyy format and 
the decimal separator must be a period and not a comma 

- put the QGIS/ArcGIS software in English 
 

4.1 Delineate watersheds and subbasins 
 
The procedure detailed below concerns the modeling with QGIS software, the 
modeling with ArcGIS software is not detailed but is comparable. It is possible to 
follow the different steps in the videos on the SWAT website: 
https://swat.tamu.edu/workshops/instructional-videos/ 
 
In the QGIS command bar, click on 'Plugins' > 'Manage and Install Plugins...' and 
check that the plugin of the downloaded version of QSWAT (e.g. 'QSWAT3_9') is 
checked. Close the window. 
 

Click on   . A window opens (Figure 8). 
 
 

(1) Click on ‘New Project’  
 

Name (e.g.: projectQSWAT.qgs) and save 
the project under the local disk in the same 
folder where the input data have been 
saved (C:/…/modelisation/projectQSWAT) 
 
In this folder, a database 
'projectQSWAT.mdb' is created. It will 
contain all the information filled in during 
the setting up of the model. 

 
(2) Click on 'Delineate Watershed', a window will open. 

 
Specify :  

- The DEM file of the study area (obtained in §3.1). 

Figure 8 : fenêtre de menu du projet QSWAT 

1 

2 
3 

4 
5 

https://www.youtube.com/watch?v=2YW0ZDNfdlU&t=711s
https://www.youtube.com/watch?v=9YQUO7EXTps
https://www.youtube.com/watch?v=xn9h_EHt6EY
https://swat.tamu.edu/media/116371/qswat-manual_v19.pdf
https://web.ics.purdue.edu/~vmerwade/education/qswat.pdf
https://swat.tamu.edu/workshops/instructional-videos/
https://swat.tamu.edu/workshops/instructional-videos/
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- The shp file of the hydrographic network (obtained in §3.2). 

 
- The streams limits "Define threshold". If necessary, adjust the values so that 

the modeled stream resembles the actual river network as closely as 
possible and the hydrometric and sampling station points overlap the 
streams. The lower the 'threshold' values, the more detailed the stream 
network, and the heavier the model, which will take longer for the next 
steps. 

→ Click on ‘Create Stream’. 
 

- The location of outlets and source points (Figure 9) : 
1. On the QGIS interface, click on Layer > Add Layer > Add Vector Layer 

and add the files sampling-points.shp and hydro-stations.shp 
(obtained in §3.3) 

 
2. Back on the 'Delineate Watershed' window, click on 'Draw 

inlets/outlets', then 'New’ 
 

 
3. Check "Outlet" and place them by clicking directly on the map at the 

same places as the points of the hydro-station.shp layer 
 

4. Also place " Outlet " points at the river outlets 
 

5. Select "Source Point" and place them directly on the map at the same 
locations as the points in the sampling-point.shp layer. 
 

Click on "Create Watershed". The subwatersheds are drawn from each outlet point 
and there is only one source point per subwatershed. 
 
Click on OK. A subbasin number is automatically assigned. 
 

= hydrometric station or outlet 

= sampling points 

Figure 9 : example of outlet and source point representation 
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4.2 Creating the Hydrological Response Units 
 
A hydrologic response unit (HRU), is a single spatial unit of the catchment 
combining a land use type, a soil type and a slope characteristic. The simulation is 
calculated for each of these HRUs. 
 
4.2.1 HRUs based on occupation, soil type and slope 
  

(3) Click on 'Create HRUs', a window opens. 
 
Specify :  

- The landuse tif layer (obtained in §3.4.1) 
- The soil type tif layer (obtained in §3.5) 
- The landuse lookup table (obtained in §3.4.2) 
- The soil type lookup table:  

o If the American (§3.5.1) or French (§3.5.3) method is chosen for the soil 
data: select 'global_soils' 

o If the English method is chosen for the soil data (§3.5.2): select 'Use 
csv file' and choose soils_lookup.csv. 

- Check 'Soil data' = usersoil 
- The most commonly used slope scales, in percentages, are: 0-1, 1-3, 3-5, 5-

8, 8-9999 %. Add '1', '3', '5', '8' 
 
Check "Generate FullHRUs shapefile", then Read. 
 
The tabs "Single/Multiple HRUs" and "Set landuse, soil, slope threshold" are 
displayed. 
We want to keep all the HRUs created: check 'Filter by landuse, soil, slope' and fill 
in the value 0 for 'Landuse', 'Soil' and 'Slope'. 
 
4.2.2 Option: subdivide HRUs by agricultural land use 
 

In the case of catchments mainly covered by agricultural surfaces, it is 
interesting to divide these surfaces by type of agricultural activity. This gives more 
precise information on the type of vegetation present and their effect on runoff by 
their capacity of retaining or evapo-transpirate the water. 
 
Method : 
 

1. From the parcel register layer obtained via the link in Table 1, use the “Clip…” 
function to cover the study area. The attribute data contains for each entity: 
the type of crop and the area. This data can be exported to a spreadsheet in 
csv format (Right click on the layer > Export > Save Vector Layer as ... > 
Format = [CSV]) which allows the calculation of the percentage of 
agricultural land that has been attributed to each crop type. 

 
2. In the 'Create HRUs' window (3) → 'Optional' tab → click on 'Split landuses'. 
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3. In 'Select landuse to split', choose 'AGRL' and indicate the types of crops 
and their area in percent. 

 
4.3 Run the model 

(4) Click on 'Edit Inputs and Run SWAT', which will open the SWAT Editor 

extension  
 
4.3.1 Connect Project Databases 
 
A window opens (Figure 10). It is used to fill in the project databases. 

 
➔ Click on "Connect to Database", the tabs will unfold. 

 
From this point on, the commands presented are similar to those of ArcSWAT in 
ArcGIS. 
 
4.3.2 Recording weather data 
 
‘Weather generator’:  
 
In the section “Write Input tables” > “Weather Stations”, a window “Weather Data 
Definition” opens up (Figure 11). There are 6 sections, the first of which is “Weather 
Generator Data”:  
 

➔ Record table “WGEN_projet” (§3.6.2) or “WGEN_CFSR_WORLD” (§3.6.3) 

C:\...\projectQSWAT\projectQSW
AT.mdb 

C:\...\projectQSWAT\QSWATRef2012.
mdb 

C:\...\projectQSWAT\QSWATRef201
2.mdb 

Figure 10: SWAT Editor main menu widow 



 
Transferable Catchment Model 

31 
 

 

Daily weather data: 
 
In each of the other five sections, the station files are entered ‘pcp.txt’, ‘tmp.txt’, 
‘rh.txt’, ‘solar.txt’, ‘wind.txt’ obtained in §3.6.1). SWAT will automatically read the 
associated daily data files located in the same folder. 
If weather data is not available, check “Simulation”. SWAT will simulate the 
weather data from the weather generator or “Weather Generator”.  
 
 
4.3.3 Define the calculation methods and record the known parameters 
 
In the section “Edit SWAT Input” in Figure 10, it is possible to enter the known 
model parameters for: 

- “Point source Discharge” 
- “Inlet Discharge” 
- “Reservoirs” 
- “Subbasin Data” 
- “Watershed Data” 

 
• Initially, to model the flows in a catchment area, it is especially interesting to 

fill in the details in the section “Subbasin Data” among the following data 
parameters:  

- general data (.bsn) : 
https://swat.tamu.edu/media/69311/ch04_input_bsn.pdf  

- soil data (.sol) : 
https://swat.tamu.edu/media/69365/ch22_input_sol.pdf 

- HRUs data (.hru) : 
https://swat.tamu.edu/media/69356/ch19_input_hru.pdf  

- network routing data (.rte) : 
https://swat.tamu.edu/media/69374/ch25_input_rte.pdf 

- aquifer data (.gw) : 
https://swat.tamu.edu/media/69371/ch24_input_gw.pdf  

- agricultural management data (.mgt) : 
https://swat.tamu.edu/media/69359/ch20_input_mgt.pdf  

 
It is possible to apply the parameters to only one type of HRU “Extend Edits to 
Current HRU”, to all HRUs “Extend Edits to All HRUs”, to those selected “Extend 

Figure 11: window for the integration of weather data 

https://swat.tamu.edu/media/69311/ch04_input_bsn.pdf
https://swat.tamu.edu/media/69365/ch22_input_sol.pdf
https://swat.tamu.edu/media/69356/ch19_input_hru.pdf
https://swat.tamu.edu/media/69374/ch25_input_rte.pdf
https://swat.tamu.edu/media/69371/ch24_input_gw.pdf
https://swat.tamu.edu/media/69359/ch20_input_mgt.pdf
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Edits to Selected HRUs” or to entire catchment “Extend ALL General 
Parameter”. 
Modify the value of the known parameters, among the 4 existing tabs. 
If the parameters are not known in the study catchment, the default 
parameters are retained. 

• In “Edit SWAT Input” > “Watershed Data” > “General Data (.BSN)” (Figure 12):  
- Click on “Edit Values” 
- Enter the method for calculating evapotranspiration. Choose PET 

Method = Penman/Monteith. 
- Modify the value of the known parameters, among the 4 existing tabs 

(https://swat.tamu.edu/media/69311/ch04_input_bsn.pdf) 
- Click on “Save Edits” 

 

 
Figure 12: editing window for the general parameters of the catchment area 

 
4.3.4 Launch SWAT model 
 
On the general menu (Figure 10), open the section “Write Input Table” → “Write 
SWAT Input Table”. Choose “Select All” then “Create Tables”. 
 
In the "SWAT Simulation" section, click on Run SWAT. A window opens up (Figure 
13). 

https://swat.tamu.edu/media/69311/ch04_input_bsn.pdf
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Figure 13: model launch window 

Choose the start and end date of the simulation. It is preferable to choose whole 
years (from 1st January to 31st December) for which the meteorological data are 
known. 
 
Choosing a time when the water table is full “Warm-up period”: NYSKIP ≥ 3 years. 
 
Choose the output files to be produced in the output folder, check: 

- “Daily” 
- “Print Log Flow” 
- The SWAT version is compatible with the PC used. The debug version will 

take longer to run, but will allow to highlight the location of a possible bug 
in the modelling. 

 
Click on “Setup SWAT Run”. 
Click on “Run SWAT”. 
 
A command window opens and the modelling starts. This may take several 
minutes. 
A message is displayed “SWAT run successful”, the modelling worked. 
A message is displayed “SWAT run NOT successful”, modelling did not work. 
Restart SWAT in ‘debug’ mode. The command window indicates where the error 
is: copy and paste the error into the forum 
https://groups.google.com/g/swatuser, where SWAT users regularly report 
model errors and their causes. Correct the file(s) causing the bug, then restart 
SWAT. 
 
4.3.5 SWAT Check 
 
Click on “SWAT Simulation” Figure 10, then “Read SWAT Output”. 
 
To see the simulation data in QSWAT/ArcSWAT and calibrate the model in SWAT-
CUP, check ‘output.rch’, then “Import Files to Database”.  
 

https://groups.google.com/g/swatuser
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SWAT simulations can be saved using the “Save Simulation”. They will be saved in 
C:\…\modelisation\projectQSWAT\Scenarios\. 
 

Click on “Run SWAT Check” 
then “Examine Model Output” 
The "Hydrology" tab presents 
the water balance of the 
model, with "Messages and 
Warnings" on possible 
abnormal hydrological events. 
 
The water balance provides 
information on the average 
annual precipitation, the 
quantity of this water that 
infiltrates, that is rejected by 
evapotranspiration and that 
runs off the soil surface 
(Figure 14).  Figure 14: example of water balance after a first simulation 
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5 Calibration of the hydrological model 
 
Once the model is in place and the desired simulation is launched, a calibration 
step of the model is necessary. 
 
The steps of the model calibration performed on the SWAT-CUP software can be 
followed according to the tutorials and manuals below: 

- https://swat.tamu.edu/media/114860/usermanual_swatcup.pdf 
- https://www.youtube.com/watch?v=lPY_5HxFB_8 
- https://www.youtube.com/watch?v=Kqa3HHka8sI&list=PLjDkjZqbf4OtJ3

6tToupeMAbBCY9ffu00&index=7  
 

5.1 Implementation of the model in SWAT-CUP   
 
Appendix 1 provides the general principle of the SWAT-CUP steps.  
Open the SWAT-CUP software. 
 

(1) Click the Start button at the top left (Figure 15).  
 

Under  C\...\modeling\projectQSWAT\Scenarios\Default\  or 
C\...\Scenarios\Sim1\ (if different simulations have been started), locate the 
'TxtInOut' folder of the project where all simulation data is saved, including 
'output.rch' data. 

 
Choose the version of SWAT used and the architecture of the 32 or 64-bit 

processor. 
 

Choose "Project Type" = SUFI2 
 

Choose the name of the project and its location in the computer. 
Example: C\...\modeling\projectQSWAT _calibration. Sufi2.SwatCup 

 
Click Finish. The data is imported into SWAT-CUP. 

 
5.2 Check model performance 

 
1. Add observed flow data: 

 
(2) In the "Project Explorer" panel, click on "Rch", expand the "Observation" tab 

and open "Observed_rch.txt". 
 

(3) Replace the number of observed variables. During the calibration step, only 
one variable is chosen, that of the flow observed at the reference 
hydrometric station. During the validation step, there will be as many 
variables observed as sampling points filled in with extrapolated observed 
flows. 
 

(4) Replace the number of the sub-basin concerned with the observed data. 
First, the number of the sub-basin whose observed data come from a 

https://swat.tamu.edu/media/114860/usermanual_swatcup.pdf
https://www.youtube.com/watch?v=lPY_5HxFB_8
https://www.youtube.com/watch?v=Kqa3HHka8sI&list=PLjDkjZqbf4OtJ36tToupeMAbBCY9ffu00&index=7
https://www.youtube.com/watch?v=Kqa3HHka8sI&list=PLjDkjZqbf4OtJ36tToupeMAbBCY9ffu00&index=7
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hydrometric station is entered. All other points will be filled in for the 
validation step. 

 
(5) Replace the number of daily flow data observed for this point. 
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Figure 15: SWAT-CUP interface screen printing 
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(6) Remove and paste the observed daily flow data formatted in Figure 7 of 
§3.7.1 
For the calibration step, the observed flow data from the reference 
hydrometric station are provided. 
For the validation step, add the other flow data observed below one after 
the other by repeating the instructions from (1) to (6). 
 

(7) Fill in the following files, following the tutorials and manuals: 
o Extraction > “Var_file_rch.txt” 
o Extraction > “SUFI2_extract_rch.def” 
o Objective Function > “Observed.txt” 
o Objective Function > “Var_file_name.txt” 
o No Observation > “Extract_rch_No_Obs.def” 
o No Observation > “Extract_hru_No_Obs.def” 
o No Observation > “Extract_sub_No_Obs.def” 
o No Observation > “95ppu_No_Obs.def” 

 
2. Launch the template without changes: 

 
(8) We try to launch the model for the first time without changing the 

parameters. In Calibration Inputs > Par_inf.txt, remove the four 
default settings, and add the SFTMP parameter (.bsn). Complete as 
shown in Figure 16.  

 

 
Figure 16 : screen impression of the parameters to be filled in to launch the template for the first time 

 
(9) In Calibration Inputs > SUFI2_swEdit.def, enter the value 1 in "starting 

simulation number" and "ending simulation number". 
 

(10) Save all changes 
 
(11) Click on "Calibrate" to start the calibration. 

A window opens (Figure 17). Launch in order: 
SUFI2_pre.bat, SUFI2_run.bat then SUFI2_post.bat. 
Save the name of this first simulation (example: Iter1). 

 
 
3. Observe model performance: 
 
In the "Project Explorer" panel, scroll down "Iteration History" > "Iter1" > "Calibration 
Outputs" 
 

- Open 95 ppu plot (Figure 18). This graph compares the simulated flow to the 
observed flow. Depending on the shape of the graph, we will be able to 
know which parameters are to be targeted to adjust the model.   

Figure 17 : calibration 
launch window 
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Figure 18: example of a graph of a first uncalibrated simulation 

- Open "Summary_Stat.txt". This file informs us about the correlation 
coefficients between observed and simulated flow. Figure 19 shows R2 = 
0.51, MSE = 1.1, PBIAS = 88.3, which is far from the desired values (§2.4.5). The 
model here is not validated, it is necessary to calibrate it. 
 

 

 
Figure 19: example of coefficient value for a simulated uncalibrated flow rate 

 
5.3 Sensitivity analysis: select the most influential parameters of the 

model 
 
Appendix 2 presents the 53 parameters that can influence the water balance of a 
catchment to be tested for sensitivity analysis. 
Annex 3 presents the parameters to be varied according to the trend of the 
observed and simulated flow curves and helps to identify the most influential 
parameters. 
The purpose of sensitivity analysis is to test all parameters individually by slightly 
changing their initial value to see if they have an influence on the model. This is the 
"Once-at-a-time" or "OAT" method.  
 
For each parameter to be tested individually, in Par_inf.txt fill in minimum and 
maximum values that slightly vary the initial values and launch only three iterations 
(Figure 20). 
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Figure 20: example of a parameter to test for sensitivity analysis 

 
The three ways to change the "Min" and "Max" values to test are:  

- r – Relative: multiplies the existing value by (1+given value) 
- a – Absolute: adds the given value to the existing value  
- v – Replace: replaces the existing value with the given values 

 
Launch under "Calibrate": SUFI2_pre.bat and SUFI2_run.bat (Figure 17). 
 
Scroll down « Sensitivity Analysis » > One-at-time. 
If the flow curves of the three simulation values tested do not differ from the 
observed values, then this parameter is not retained for the calibration step 
If there is a difference between the three flow curves, then this parameter will have 
to be calibrated (Figure 21). 
 

 
Figure 21: example of a graphical representation of a sensitive parameter 

 
5.4 Self-calibration 

 
Once the sensitive parameters have been identified, enter them into Par_inf.txt. 
Assign them minimum and maximum values using Annex 3 to try to target the 
scale of values to be tested for calibration. These values are to be varied according 
to the knowledge of the hydrology of the catchment concerned by the modeling. 
 
To run a suitable number of simulations, multiply by 100 the number of parameters 
retained. For example, for 15 sensitive parameters, there will be 1500 simulations. 
This number can be reduced if the size of the model is too large. 
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Lancer Execute All sous « Calibrate » (Figure 17). 
 
An example of a calibrated result is shown in Figure 22. 
In order to obtain satisfactory results following self-calibration, it may be 
interesting to perform a manual calibration, by manually changing the parameters 
using Annex 3.  
 
The data at the output of the calibration:  

- 95ppu plot: shows graphs of calibrated simulated flow rates and observed 
flow rates 

- Best_Par.txt: shows the best values of the parameters, that is, the values 
that give the closest simulation to the objective.  

- Best-Sim.txt: This file shows the best simulated values for all parameters 
used. Observed and simulated data are given to be easily graphed. 

- Goal.txt: The file shows the values of all parameters used for the 
simulations performed as well as the target value in the last column. 

- New_Pars.txt: This file shows suggested values for new parameters to use 
in future iterations. These values can be copied and pasted into the 
Par_inf.txt file, "Text View" tab.  

- Summary_Stat.txt: This file shows the statistics of comparison between 
the observed data and the simulations. 
 

 
Figure 22: example of calibrated daily flow, compared to Figure 18 without calibration 

 
5.5 Model validation 

 
1. Implementation and execution of the validation step: 
 

Once adjusted, the values of the sensitive parameters will be applied to the other 
hydrometric stations and samples.  
 
Repeat steps (2) to (7) of §5.2, indicating the observed flows of the other stations. 

 
In Par_inf.txt, click on "Import New Parameters". This will automatically 
add the values of the parameters adjusted during the calibration step, 
indicated in the "New_pars.txt" file. 

 
Indicate the same number of simulations as in the calibration step. 
 
Lancer la simulation “Execute all” (Figure 17). 
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2. Confirmation of validation 

 
- In the 95ppu plot file, check the speed of the calibrated simulated flow 

curves in relation to those of the observed flow rates. 
It is possible to switch from one chart to another by clicking on the "Record 
x of x" arrows. 
 

- In the Summary_stat.txt file, check that the values of correlation 
coefficients are satisfactory (R2 > 0.6, PBIAS tends to 0).  

 
If the criteria of pace and coefficients are satisfactory, the hydraulic model is 
validated. 
Adjusted parameter values are kept to inform microplastics flow modelling. 
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6 Simulation of microplastic flows 
 
Now that the hydrological model is calibrated and validated, the values of the 
parameterized hydrological variables can be applied to the modelling of MP flows.  
 

6.1 Daily microplastic calculations 
 
By following the river sampling steps of the T1.1.2 deliverable, a number of MPs is 
obtained at several points in the catchment. 
Knowing the number of MP obtained and the water filtration time, it is possible to 
estimate the number of microplastics passed on the day of sampling and at each 
point sampled with the following formula:  
 

𝑁𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑀𝑃

𝑆𝑎𝑚𝑝𝑙𝑒 𝑡𝑖𝑚𝑒 (𝑚𝑖𝑛𝑢𝑡𝑒𝑠)
 × 1440 (

𝑚𝑖𝑛𝑢𝑡𝑒𝑠

𝑑𝑎𝑦
) = 𝐷𝑎𝑖𝑙𝑦 𝑛𝑢𝑚𝑏𝑒𝑟 𝑜𝑓 𝑀𝑃 (

𝑀𝑃

𝑑𝑎𝑦
) 

 
 
In the case of monthly or trimestral samplings, the same daily flow value of MP 
may be entered for the entire month or trimester concerned for each point. 
 
In the case of less regular sampling (example: 2 per year for 3 years), it is possible 
to average the MP/day fluxes for these 6 samples. This same value will be entered 
each day of the simulation and for the x points sampled. 
 
 

6.2 Modeling microplastic flows in SWAT 
 
MP flow simulation is not included in the SWAT model. However, it provides 
information on sediment flow. By approximating that MP tends to move, settle 
and be re-suspended like suspended matter, it is possible to integrate MP into the 
SWAT model. 
 
6.2.1 Data formatting 
 
Each sub-basin created in the "Delineate Watershed" step is associated with a 
source point (§4.1). In order for microplastics input data to be read by SWAT, a .txt 
file of daily MP data must be created for each sampling point following the model 
of the dailypoints.txt file located at: C:\SWAT\SWATEditor\Databases\ExInputs.  
 
In the "Sedday" column, enter the daily, monthly or trimestral MP flow values for 
all dates of the simulation duration ("DATE" column). Enter 0 for all other variables. 
 
 
6.2.2 Integration of MP values into the SWAT model 
 
 

1. Resume the model in step §4.3.3 in SWAT Editor. 
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2. Click on "Edit SWAT Input" (Figure 10) then "Point Source Discharges". A 
dialog box opens with the list of sub-basins of the project. Select the sub-
basin (associated with a source point and therefore a sampling point) whose 
input data you want to modify. 

 
3. A dialog box opens (Figure 23). 

 

 
Figure 23: editing window for source point settings 

4. In "Select Source Data Type" choose Daily. Specify the corresponding .txt 
file obtained in §6.2.1. 
 

5. Repeat for all sub-basins/sampling points. 
 
6.2.3 Integration of the values of parameterized hydrological variables 
 

1. In the "SWAT Simulation" tab (Figure 10), open "Manual Calibration Helper" 
(Figure 24). 
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Figure 24: manual calibration window to integrate parameterized hydrological data 

 
2.  Choose one by one the parameters to which we assign the type of 

operation applied during the calibration step on SWAT-CUP (§5.3):  
- « Multiply By »  r – Relative  
- « Add »  a - Absolute 
- « Replace Value »  v – Replace 

 
3. Fill in the parameterized value 

 
4. Choose "All" for all HRUs. 

 
5. Click Update Parameter, until the message "Parameter Successfully 

Changed!" appears. 
 

6. Repeat for each parameter you want to change and then exit 
 

 
6.2.4 Launching the model with microplastics data 

 
Repeat steps §4.3.4 and §4.3.5. 
Save the simulation as "Sim_MP" for example and import the files 'output.rch' and 
'output.sub'. 
 

6.3 Visualization of microplastic flows 
 
In "Visualize" ((5), Figure 8), it is possible to display the results as a map or graph. 
 
6.3.1 View results as a fixed map 
 

- Click on the "Static maps" tab 
- Choose the desired scenario (Ex: "Sim_MP") 
- Choose "Output table" = rch to see the results by stream or = sub to see the 

results by sub-basin. 
- Choose the desired simulation dates 
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- Choose the variable "FLOW_OUTcms" to visualize the flow rate or 
"SED_OUTtons" to visualize the MP flows. 

- In "Choose summary", it is possible to view the average daily, monthly, 
annual, maximum or minimum results. 

 
Figure 25 shows the example of average daily flows and average daily flows in 
rivers over the period from 2020 to 2022 for the Bay of Veys catchment as part of 
the PPP project. 
This map identifies microplastics source areas (the "BDV08" sub-catchment) and 
the accumulation zones (the "BDV15" and "BDV11" sub-basins). 
 

 
Figure 25: example of a result obtained by viewing a static map. On the left the average daily flow 
rates, on the right the average daily microplastic flows (source: LABOCEA, PPP – INTERREG AMF). 

 
 
6.3.2 View results as an animation 

- Click on the "Animated maps" tab 
- Choose the desired scenario (Ex: "Sim_MP") 
- Choose "Output table" = rch    to see the results by stream or = sub to see 

the results by sub-basins 
- Choose the desired simulation dates 
- In "Variable", choose "FLOW_OUTcms" to view the flow rate or 

"SED_OUTtons" to view the MP flows. 
- Click on "Start Recording" then the arrow "Start button" to save a video in 

.gif format. 
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6.3.3 Visualize flow results graphically 
 

- Click on the "Plots" tab 
- Choose the desired scenario (Ex: "Sim_MP") 
- Choose "Output table" = rch    to see the results by stream or = sub to see 

the results by sub-basins. 
- Choose the desired simulation dates 
- Choose the desired sub-basin. This can be the outlet of a river before joining 

the sea. 
- In "Variable", choose "FLOW_OUTcms" to view the flow rate or 

"SED_OUTtons" to view the MP flows. 
- Click on "Add plot". 
- Save the table as the desired folder. It includes a column with dates and a 

column with daily MP flows or flows. 
- Under the spreadsheet, it is possible to add a column that informs the 

rainfall on the corresponding dates and then to form the type of graph 
presented in Figure 26. 

 

 
Figure 26: example of a graph of daily flow of microplastics as a function of rainfall at an outlet point. 

 
 

0

5

10

15

20

25

30

350

50

100

150

200

250

0
1/

20

0
2/

20
0

3/
20

0
4/

20

0
5/

20

0
6

/2
0

0
7/

20

0
8

/2
0

0
9

/2
0

10
/2

0

11
/2

0

12
/2

0

0
1/

21

0
2/

21
0

3/
21

0
4/

21

0
5/

21

0
6

/2
1

0
7/

21

0
8

/2
1

0
9

/2
1

10
/2

1

11
/2

1

12
/2

1

0
1/

22

0
2/

22
0

3/
22

0
4/

22

Precipitation (mm) MP concentration (nb/day)



 
Transferable Catchment Model 

48 
 

6.3.4 APPENDIX 
 
Appendix 1: General principle of how model calibration works with SWAT-CUP 
 

 
   



 
Transferable Catchment Model 

49 
 

Appendix 2: List of parameters for which sensitivity analysis is to be tested to 
calibrate the flow rat 
 
 
Table CRNAME MIN_ MAX_ DEFAULT UNITS DEF 

gw ALPHA_BF 0 1 0.048 [days] Baseflow alpha factor. 

gw ALPHA_BF_D 0 1 0.01 [days] Baseflow alpha factor for deep aquifer. 

gw SHALLST 0 5000 1000 [mm] 
Initial depth of water in the shallow 
aquifer. 

gw DEEPST 0 10000 2000 [mm] Initial depth of water in the deep aquifer . 

gw GW_DELAY 0 500 31 [days] Groundwater delay. 

gw GWQMN 0 5000 1000 [mm] 
Threshold depth of water in the shallow 
aquifer required for return flow to occur. 

gw GW_REVAP 0.02 0.2 0.02 na Groundwater "revap" coefficient. 

gw REVAPMN 0 1000 750 [mm] 
Threshold depth of water in the shallow 
aquifer for "revap" to occur. 

gw RCHRG_DP 0 1 0.05 [fraction] Deep aquifer percolation fraction. 

bsn ESCO 0 1 0.95 na Soil evaporation compensation factor. 

bsn EPCO 0 1 1 na Plant uptake compensation factor. 

bsn EVLAI 0 10 3 [m²/m²] 
Leaf area index at which no evaporation 
occurs from water surface. 

bsn FFCB 0 1 0 [fraction] 
Initial soil water storage expressed as a 
fraction of field capacity water content. 

bsn SURLAG 1 24 4 [days] Surface runoff lag time. 

bsn MSK_CO1 0 10 0.75 na 
Calibration coefficient used to control 
impact of the storage time constant for 
normal flow. 

bsn MSK_CO2 0 10 0.25 na 
Calibration coefficient used to control 
impact of the storage time constant for 
low flow . 

bsn MSK_X 0 0.3 0.2 na 

Weighting factor controlling relative 
importance of inflow rate and outflow 
rate in determining water storage in 
reach segment. 

bsn EVRCH 0.5 1 1 na Reach evaporation adjustment factor. 

bsn CNCOEF 0.5 2 1 na Plant ET curve number coefficient. 

hru SLSUBBSN 10 150 50 [m] Average slope length. 

hru HRU_SLP 0 0.6 -999 [m/m] Average slope steepness. 

hru OV_N 0.01 30 -999 na Manning's "n" value for overland flow. 

hru LAT_TTIME 0 180 0 [days] Lateral flow travel time. 

hru SLSOIL 0 150 0 [m] Slope length for lateral subsurface flow. 

rte CH_W2 0 1000 -999 [m] Average width of main channel. 

rte CH_D 0 30 -999 [m] Average depth of main channel. 

rte CH_S2 -0.001 10 -999 [m/m] Average slope of main channel. 

rte CH_L2 -0.05 500 -999 [km] Length of main channel. 
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rte CH_N2 -0.01 0.3 0.014 na 
Manning's "n" value for the main 
channel. 

rte CH_K2 -0.01 500 0 [mm/hr] 
Effective hydraulic conductivity in main 
channel alluvium. 

sol SOL_Z 0 3500 -999 [mm] 
Depth from soil surface to bottom of 
layer. 

sol SOL_BD 0.9 2.5 -999 [g/cm3] Moist bulk density. 

sol SOL_AWC 0 1 -999 [mm/mm] Available water capacity of the soil layer. 

sol SOL_K 0 2000 -999 [mm/hr] Saturated hydraulic conductivity. 

sol CLAY 0 100 -999 [%] Clay content. 

sol SILT 0 100 -999 [%] Silt content. 

sol SAND 0 100 -999 [%] Sand content. 

sol ROCK 0 100 -999 [%] Rock fragment content. 

sol SOL_ALB 0 0.25 -999 na Moist soil albedo. 

sol USLE_K 0 0.65 -999 na USLE equation soil erodibility (K) factor. 

sub CH_L1 0.05 200 -999 [km] 
Longest tributary channel length in 
subbasin. 

sub CH_S1 0.0001 10 -999 [m/m] Average slope of tributary channels. 

sub CH_W1 1 1000 -999 [m] Average width of tributary channels (m). 

sub CH_K1 0 300 0 [mm/hr] 
Effective hydraulic conductivity in 
tributary channel alluvium . 

sub CH_N1 0.01 30 0.014 na 
Manning's "n" value for the tributary 
channels. 

sub RFINC 0 100 0 [%] Rainfall adjustment. 

sub TMPINC 0 100 0 [deg C] Temperature adjustment. 

sub RADINC 0 100 0 
[MJ/m2-
day] 

Radiation adjustment. 

sub HUMINC -1 1 0 [fraction] Humidity adjustment. 

crop BIO_E 10 90   Biomass/Energy Ratio. 

crop HVSTI 0.01 1.25   Harvest index. 

crop BLAI 0.5 10   Max leaf area index. 

crop CN2 25 98   SCS runoff curve number for moisture 
condition II. 
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APPENDIX 3: aid for the calibration of the model according to the form of the 
graph of the simulated flows in relation to the observed flows 
 
Rules for parameter calibration. ↑ indicates that the parameter should 
increase, ↓ indicates that the parameter should decrease. (For more details, 
see the documentation on validating SWAT calibration.  literature 
http://swat.tamu.edu/publications/calibrationvalidation-publications/). 

 

Simulated condition and 

significant parameters 

Before (top) and after (below) parameter regionalization 

- Base flow too low 

 

- Evapotranspiration too high 

GWQMN.gw ↓ 

GW_REVAP.gw ↓ 

REVAMPM.gw ↑ 

Peak flow too low 

 

CN2.mgt ↑ 

SOL_AWC.sol ↓ 

ESCO.hru ↓ 

  

  

  

http://swat.tamu.edu/publications/calibrationvalidation-publications/


 
Transferable Catchment Model 

52 
 

Simulated condition and 

significant parameters 

Before (top) and after (below) parameter regionalization 

Discharge shift to the right 

 

HRU_SLP ↑ 

OV_N.hru ↓ 

SLSUBBSN.hru ↓ 

– Base flow too high 

 

– Peaks too low 

CN2.mgt ↑ 

SOL_AWC.sol ↓ 

ESCO.hru ↓ 

GWQMN.gw ↑ 

GW_REVAP.gw ↑ 

REVAMPM.gw ↓ 

Nitrate load too high 

 

SHALLST_N.gw ↓ 

RCN.bsn ↓ 

NPERO.bsn ↓ 

CMN.bsn ↓ 

SOL_NO3.chm ↓ 

FRT_SURFACE.mgt ↓ (in our 

case also decreasing 

parameter α in Eq. (1)) 

(3) 
Based on parameters identified in step 2 and one-at-a-time sensitivity analysis, 
initial ranges are assigned to parameters of significance. Experience and 

https://www.sciencedirect.com/science/article/pii/S0022169415001985#e0005
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hydrological knowledge of the analyst is also of great asset in defining parameter 
ranges. In addition to the initial ranges, user-defined absolute parameter ranges 
are also defined for every SWAT parameter in SWAT-CUP where parameters are 
not allowed to be outside of this range. 

(4) 
Once the model is parameterized and the ranges are assigned, the model is run 
some 300–1000 times, depending on the number of parameters, speed of the 
model execution, and the system capabilities. Great time saving could be achieved 
by using the parallel processing option of SWAT-CUP (Rouholahnejad et al., 2012). 
 

(5) 
After all simulations are completed; the post processing option in SWAT-CUP 
calculates the objective function and the 95PPU for all observed variables in the 
objective function. New parameter ranges are suggested by the program for 
another iteration, which modifies the previous ranges focusing on the best 
parameter set of the current iteration (Abbaspour et al., 2004, Abbaspour et al., 
2007). 
 

(6) 
The suggested new parameter ranges could be modifies by the user using Table 
2 and one-at-a-time sensitivity analysis again. Another iteration is then performed. 
The procedure continues until satisfactory results are reached (in terms of the P-
factor and R-factor) or no further improvements are seen in the objective function. 
Normally, three to five iterations are sufficient for satisfactory results. More 
detailed information could be found in Abbaspour et al., 2004, Abbaspour et al., 
2007 and Rouholahnejad et al. (2012). 
 
 

https://www.sciencedirect.com/science/article/pii/S0022169415001985#b0200
https://www.sciencedirect.com/science/article/pii/S0022169415001985#b0015
https://www.sciencedirect.com/science/article/pii/S0022169415001985#b0020
https://www.sciencedirect.com/science/article/pii/S0022169415001985#b0020
https://www.sciencedirect.com/science/article/pii/S0022169415001985#t0010
https://www.sciencedirect.com/science/article/pii/S0022169415001985#t0010
https://www.sciencedirect.com/science/article/pii/S0022169415001985#b0015
https://www.sciencedirect.com/science/article/pii/S0022169415001985#b0020
https://www.sciencedirect.com/science/article/pii/S0022169415001985#b0020
https://www.sciencedirect.com/science/article/pii/S0022169415001985#b0200
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PART 2: MODELING THE DISPERSION OF 
MICROPLASTICS AT SEA 
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7 Oceanographic modelling 
 

7.1 Introduction 
 
To characterise the behaviour of plastics at sea, the first step is to obtain a 
representation of the oceanographic and meteorological conditions of the area 
under study. During their drift at sea, plastics are essentially carried along by the 
current and by the waves. Wind is also taken into account for macroplastics. To 
calculate the drift of plastics under the effect of these elements, it is necessary to 
have this information at a sufficiently fine spatial resolution, capable of 
representing all the variability of oceanic conditions, and over a relatively long 
period, capable of reproducing the temporal variability of these phenomena. Only 
data from numerical modelling can meet this need. 
At the scale of a sea or ocean, several sources of this type of data are freely 
available and do not require additional modelling work. At the scale of a bay 
downstream of a catchment, such data generally do not exist. It is therefore 
necessary to build, validate and operate these models. There is no single 
methodology applicable to all catchments. Several tools exist and can be used, 
each of which will need to be adapted to the area under study, requiring a level of 
expertise that is not available to a non-specialist. 
 
The following sections describe the standard procedures to be used to build the 
different models required for this work. 
 

7.2 Current modelling 

7.2.1 Choice of the current model 
A current 'model' is a computer program whose purpose is to calculate, at each 
point of a geographical grid, the speed and direction of the current, taking into 
account all the contributing phenomena, including: 

- The tide ; 
- The effects of wind and other atmospheric parameters (such as pressure); 
- Large-scale regional circulation effects; 
- River flows; 
- The shape of the seabed (bathymetry) and coastline. 

To simplify the approach, we have chosen to focus only on plastics at the sea 
surface, and not to study the behaviour of plastics that may fall into the water 
column and settle on the seabed. Depending on the nature of the current 
phenomena, it is therefore sometimes sufficient to use a two-dimensional (2D) 
model which does not provide information on the variation of the current at depth. 
The use of a 3D model is only necessary if current phenomena due to the 
stratification of the water in temperature and salinity have a significant impact on 
the current at the surface. This is the case in the Mediterranean Sea, for example. 
For all the sites studied in the framework of PPP, a 2D model was used. 
Several 2D current models can be used for this type of study, for example : 

- MARS : https://dyneco.ifremer.fr/Nos-
equipes/DHYSED/Outils/Modelisation/MARS  

- CROCO : https://www.croco-ocean.org/ 
 

For our PPP applications, MARS model was used.  

https://dyneco.ifremer.fr/Nos-equipes/DHYSED/Outils/Modelisation/MARS
https://dyneco.ifremer.fr/Nos-equipes/DHYSED/Outils/Modelisation/MARS
https://www.croco-ocean.org/
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The current model operates on a computational "grid", on which the current 
characteristics are calculated. The resolution of the grid is the spacing between 
each grid point. To correctly represent the hydrodynamics of a coastal area, this 
resolution should be a few tens of metres. In PPP, the models built had a resolution 
of 50 to 60 metres. 
 
7.2.2 Input data 
The main input to the model is the mapping of the seabed (bathymetry). This 
mapping must be at least as accurate as the resolution of the model grid. Global 
databases such as GEBCO or ETOPO are not sufficient to meet this need. There is 
no unified database that can provide sufficiently accurate bathymetry at any site, 
and these data are not necessarily free of charge. For French sites, the 
www.data.shom.fr website provides most of the available data. The "Master Data 
→ Coastal Altimetry" and "Master Data → Bathymetry" entries in the drop-down 
menu should be consulted (see Figure 27). 
 

 
Figure 27 : Screen copy of the webste www.data.shom.fr to illustrate the request for bathymetry in 
french areas 

For English sites, a specific search must be conducted for each new application. 
The site https://www.oceanwise.eu/data/dem/ can provide bathymetry data for 
a fee. For the PPP project, only the Plymouth site was processed. The bathymetry 
was provided by the University of Plymouth, a project partner. 
 
Another essential piece of data is the tidal components at the boundaries of the 
current model. We recommend using the FES2014 database which describes these 
tidal components worldwide. More accurate regional databases may exist locally, 
as is the case in Finistère with the PREVIMER database. The modelling did not 
show significant differences with the use of the global database. The FES2014 
database therefore seems to be the best compromise. 
 
Finally, it is necessary to use atmospheric data (wind and pressure) to force the 
current model. This aspect is dealt with in chapter 7.4. 
 

https://www.oceanwise.eu/data/dem/
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7.2.3 Validation 
The validation of a model consists of checking its accuracy against the ground 
truth, generally obtained by in situ measurements. It is necessary to validate the 
current models in terms of 

- Water level 
- Speed and direction of currents 

To validate the water level, there are several tide gauges along the French and 
English coasts which constitute the best possible source of data. As with 
bathymetry, French tide gauge data can be accessed via the website 
www.data.shom.fr, via the drop-down menu "Master data →  Coastal observations 
→  Sea Level". 
The water level validation consists of superimposing the observed water level and 
the water level calculated by the model. It is then possible to calculate statistical 
errors between these two values, the root mean square error and the correlation 
are very good indicators of the accuracy of the model. The tide is generally very 
well represented by the models, correlations above 0.95 are expected, and the 
mean square error should be only a few percent. 
 
 

 
Figure 28 : Example of comparison between model (Seamer) and measurements (SHOM) for Brest 

tide gauge. 

 
Current validation is usually hampered by the availability of measurement data. A 
site-specific search must be conducted. Some marine charts show current values 
over typical tidal cycles at certain points. This method has been used to validate 
the current in the Tamar area (see Figure 29). On this type of data, comparing 
current ellipses is generally the best method to use. The current ellipse is the 
representation in an orthonormal frame of the end of the current vector (with the 
origin positioned at the centre of the frame) at each hour of the tide (see Figure 
29, right). The visual comparison of the ellipses is usually sufficient to judge the 
quality of the model. 
 

file://///labocea.fr/Espace_Organigramme/CD_RECHERCHE_DEVELOPPEMENT/x%20communs/PLASTIQUES/Preventing%20Plastic%20Pollution/WP%20G/Guidance/MTT1%20modelisations%20BV%20et%20mer/www.data.shom.fr
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Figure 29 : Position of the measurement points (left) and comparison of the current velocities 

between model and measurement at point E for a tidal cycle (right). 

The model calibration phase consists of adjusting certain parameters of the model 
to improve its performance on the diagnostics presented above. 

 

7.3 Wave modelling 

7.3.1 Need of a wave modelling 
Depending on the configuration studied, the effect of waves on plastic drift cannot 
be neglected. The effect of waves on the drift of plastics at the sea surface occurs 
via the "Stokes drift". This Stokes drift is significant if the waves have a long period 
and are high enough. Only long offshore swells generally meet these criteria. At 
sites where the agitation is low or only due to a local wind effect, the effect of 
waves on the drift can be neglected.  
In the framework of PPP, the effect of waves was taken into account in the Bay of 
Douarnenez, where we showed that it is predominant. On the 3 other sites 
modelled for the marine part, we neglected this parameter in the first approach. 
 
7.3.2 Choice of the wave model 
As with current modelling, it is necessary to build a configuration capable of 
calculating waves over a given area from an existing computational code, 
including the calculation of the Stokes drift. Several calculation codes can meet 
this need, for example: 

- WW3 : https://github.com/NOAA-EMC/WW3  
- SWAN :https://www.tudelft.nl/citg/over-faculteit/afdelingen/hydraulic-

engineering/sections/environmental-fluid-mechanics/research/swan 
- TELEMAC : http://www.opentelemac.org/index.php/presentation?id=20  

For the purposes of PPP, the SWAN model was used. 
 
7.3.3 Input data 
The input data required for a wave model are 

- Bathymetry 
- Atmospheric forcing (wind and pressure) 
- Offshore wave conditions. 

The first two points have already been dealt with for current modelling and are not 
re-developed here. 

https://github.com/NOAA-EMC/WW3
https://www.tudelft.nl/citg/over-faculteit/afdelingen/hydraulic-engineering/sections/environmental-fluid-mechanics/research/swan
https://www.tudelft.nl/citg/over-faculteit/afdelingen/hydraulic-engineering/sections/environmental-fluid-mechanics/research/swan
http://www.opentelemac.org/index.php/presentation?id=20
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The offshore wave conditions must be derived from a larger model, usually a 
global model. Actimar operates its own global wave model, and this was used for 
the Bay of Douarnenez. 
Free alternatives exist, several of which are listed on the 
https://data.marine.copernicus.eu/products?facets=mainVariables%7EWave 
webpage. The European Northwest Shelf model presented on this page is an 
optimal solution for the Channel sites. The global Waverys model can also be used. 
 
7.3.4 Validation 
The validation of a wave model requires the comparison of wave height, period 
and direction. As with currents, the availability of in situ measurement data is 
generally a barrier to validation. These measurements generally come from fixed 
buoys or satellite measurements.  
For the bay of Douarnenez, no validation could be carried out due to lack of 
available measurements. Satellite measurements are not available on very coastal 
points and could not be used on this site. 
 

7.4 Meteorological modelling 
Meteorological data is needed for two aspects in modelling plastic drift: 

- For the direct effect of wind on the drift of macroplastics (e.g. a plastic 
bottle on the sea surface will be entrained by the wind, in addition to 
being entrained by currents) 

- As input to current and wave models. 
Even if the winds are locally modified by the topographical conditions near 
the coast, it is not necessary to represent them on a computational grid of 
a few tens of meters of resolution like the currents and waves. The wind at 
sea is generally very regular and its spatial variation scales are of the order 
of several tens of kilometres. As a first approach, large-scale wind models 
distributed by national meteorological agencies are sufficient for these 
needs. The development of meteorological models is therefore not 
necessary for offshore plastic drift applications. 
In PPP, we used wind data from the NCEP-CFSR modelling system: 
https://rda.ucar.edu/datasets/ds093.1/ .  
Other data sources that could be used, for example: 

- ECMWF 
- ICON 
- AROME and ARPEGE models from Météo-France 

 

8 Plastic drift modeling 
8.1 Choice of the computational code 

 
There are two ways of calculating the dispersion of substances under the effect of 
marine currents: the Eulerian method and the Lagrangian method. Once the 
substance whose behaviour is to be predicted is introduced into the calculation 
domain, the principle of each method is as follows: 

- Eulerian method  
This method applies to any substance, dissolved or particulate, whose 
quantity can be expressed as a concentration. The method assumes that the 

https://data.marine.copernicus.eu/products?facets=mainVariables%7EWave
https://rda.ucar.edu/datasets/ds093.1/
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calculation area is divided into a grid, whether regular or not. At the scale of 
each grid cell, the model estimates the inflow and outflow of the substance. 
These flows take place across the boundaries of the mesh, in 2 or 3 
dimensions, under the effect of currents and any other phenomenon to be 
considered (diffusion, fall velocity, etc.). The result is then expressed in 
terms of the quantity of substance in each mesh, which is generally 
translated into a concentration. 

- Lagrangian method 
This method is only applicable for countable particulate substances, the 
trajectory of each particle is then calculated separately. This trajectory is 
influenced by currents, possibly winds, or other parameters such as a falling 
speed or a behaviour that can be parameterised by equations. The result of 
the calculation is a map of the positions of each of the particles at each time 
step of the calculation. 
 
The Eulerian calculation is generally performed at the same time as the 

calculation of the currents, within the hydrodynamic model. The calculation grid is 
generally defined by the 2D or 3D model grid. This calculation is suitable for all 
dissolved substances, and for fine matter suspended in the water. 

The Lagrangian calculation is generally performed independently of the 
hydrodynamic calculation (but not necessarily). The calculation module reads the 
outputs of the hydrodynamic model to obtain the current velocities at each 
position of the calculated trajectories (this usually involves interpolations in time 
and space). This mode of calculation can be applied to any object or particle on 
the sea surface or suspended in the water. 
 
In the case of microplastics, the choice between Eulerian and Lagrangian 
calculation is possible: 

- Microplastics are floating or suspended particles in the water, visible and 
countable. This argues in favour of a Lagrangian type of drift calculation. 

- Large microplastic particles are indeed countable, but the size spectrum 
covered by microplastics is very wide and the number of particles can be 
very large. It is common to express quantities as concentrations. These 
characteristics are therefore in line with an Eulerian approach. 

 
In this project, we finally chose a Lagrangian approach, which also offered the 
possibility of calculating macroplastic drifts with the same tool. Various Lagrangian 
drift tools exist today. We have reviewed some of them to choose the most 
suitable for our problem. Among the existing tools, we can mention: 

- Ichtyop: a tool dedicated to the calculation of fish larvae and eggs drift 
(http://www.ichthyop.org/). It is a tool coded in Java language. 

- ARIANE: a Lagrangian drift tool widely used for calculating water mass 
displacements, mainly in the deep sea: http://stockage.univ-
brest.fr/~grima/Ariane/whatsariane.html  It is a tool developed in Fortran 

- OpenDrift: generic drift calculation tool provided with some specific 
modules: oil slick drift, object drift, fish eggs drift.... 
(https://github.com/OpenDrift/opendrift/wiki). A module dedicated to 
microplastics (named plastdrift) was introduced in 2019 by a Norwegian 
laboratory. It is a tool developed in Python. 

- Parcels: generic Lagrangian drift tool still at the experimental stage at the 
beginning of our project (https://github.com/OceanParcels/parcels), 
developed in Python 

http://www.ichthyop.org/
http://stockage.univ-brest.fr/~grima/Ariane/whatsariane.html
http://stockage.univ-brest.fr/~grima/Ariane/whatsariane.html
https://github.com/OpenDrift/opendrift/wiki
https://github.com/OceanParcels/parcels


 

61 
 

- Pytickles 3D: Lagrangian drift tool adapted to high resolution models 
(http://stockage.univ-brest.fr/~gula/codes.html). Hybrid Python/Fortran 
tool. 

 
Within the framework of the PPP project, the choice of the OpenDrift tool was 
made, in particular because it includes a specific module, named plastdrift, 
dedicated to the calculation of platic drift. OpenDrift is free software, published 
under the GNU General Public License. The project is supported by the Norwegian 
Meteorological Institute (Met.no) and follows a long experience of the institute in 
predicting drift of objects at sea. 
 
 

8.2 Setting up the OpenDrift tool 
 
The Plastdrift module is used for plastic drift calculations, with its original settings. 
It is also possible to use the OceanDrift module, which is a generic drift module 
allowing to adjust some parameters such as windage. This module should only be 
used for macro-plastic modelling, when you want to test the calculation with 
additional windage. 
 

9 Interpretation of drift calculations 
9.1 First approach : streamlines 

This first approach consists of drawing streamlines from the results of the 
hydrodynamic modelling, without using the OpenDrift calculation, and can be 
done in the two operating modes described below (scenario and operational). 
Streamlines are a way of representing marine currents. By definition, a streamline 
is a curve in space describing the movement of a fluid and which, at any point in 
time, has a tangent parallel to the velocity of the fluid particles. In other words, it 
is a representation of the trajectories of the water particles that make up the sea 
surface. If plastic particles are assumed to follow these trajectories, these 
streamlines trace the preferred trajectories of plastics released into the sea. 
The limitations of this approach are: 

- This representation does not take into account the effect of waves 
- The streamlines change at each moment, so they are not stable situations 

that would reflect regular plastic trajectories. 
However, the observation of these maps can indicate areas of convergence of 
trajectories which will be privileged places of accumulation of plastics at sea. This 
observation is purely qualitative and cannot provide information on the quantities 
of plastic actually transported by the currents. 
The streamlines can for example be plotted using the streamlines function of the 
Python Matplotlib library. An example of a representation is given in the following 
figure. 

http://stockage.univ-brest.fr/~gula/codes.html
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Figure 30 : Example of streamlines at rising tide in the Bay of Plymouth 

 
9.2 Drift calculations by scenarios 

 
The idea of this method of calculation is to construct maps of plastic dispersion at 
sea for different recurrent conditions in the area. In this way, a dictionary of maps 
of plastic concentration at sea is built up, which can then be compared with real 
situations. 
 
9.2.1 Determining the calculation scenarios 
In this mode of calculation, the first step is to determine the typical weather and 
sea conditions in the study area. These conditions will be a combination of the 
different parameters that influence the weather and sea characteristics. In the PPP 
project areas, the following elements are generally dominant: 

- Tide 
- Wind 
- Waves 

In other areas it might be interesting to add water temperature or river flow for 
example. To determine typical scenarios, it is necessary to consider data for each 
parameter studied over a long period of time, in order to derive statistics on 
recurrent events. The data sources already described in the model setup (see 
$7.2.2 and $7.2.3) can be used for this analysis. 
Figure 31 shows a classical analysis of wind intensity and direction, performed on 
a 10-year time series. This analysis shows a fairly high variability of the wind, in 
which it can be difficult to identify recurring patterns. 
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Figure 31 : Results of a classical statistical analysis of the wind in Brest 

To overcome this limitation, another approach can be used, called the cluster 
approach. This advanced statistical method also requires the use of a long-term 
dataset of each parameter, but can use spatial data and also determine joint 
statistics of several parameters. The basic method is described in "Statistical 
methods in the atmospheric sciences" (D.S Wilks, Academic Press, 1995) and is 
based on the k-means algorithm.  This algorithm has been implemented by 
Actimar to handle wind fields. In addition to providing the characteristic patterns, 
the algorithm also provides the percentage of occurrence of each of the patterns 
over a typical year. 
Each typical situation identified by the algorithm is called a centroid. The algorithm 
also provides a time frame over a past period that indicates which centroid was 
closest to the actual situation on each day of the period. 
An example is given here to illustrate the analysis over Brest and Douarnenez area. 
The resulting centroids are displayed in Figure 32, their occurrence is shown in 
Table 8 and the cluster distribution schedule is shown in Figure 33. 
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Figure 32 : Centroids obtained for the wind for a 6 cluster analysis in Brest 

These clusters represent a variability of the wind from south to northeast, with 
the highest intensities in the southwest and west sectors. Even if this analysis 
cannot account for all possible meteorological situations, these results seem to 
be in agreement with our knowledge of the winds in the area. 
 

Cluster distribution  Occurrence  
Cluster 1 – Strong southwest wind  17%  
Cluster 2 – Moderate south wind  12.5%  
Cluster 3 – Moderate north wind  16%  
Cluster 4 – Northeast wind  21%  
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Cluster 5 – Quite weather  23%  
Cluster 6 – Very strong west wind  10.5%  

Table 8 : Occurrence of wind clusters in the Brest. 

 
The timeline in Figure 33 shows the classification of days in 2018 according to the 
6 clusters. There is quite a large variability of situations, except for clusters 4 and 
5 (north-east wind and calm weather) which show some periods of stability in the 
spring and summer months. 

 
Figure 33 : Timeline of the distribution of the days of the year 2018 according to the 6 clusters and 
distance to the centroid. 

This analysis, by the classical method or by clusters, makes it possible to 
determine the situations on which the plastic dispersion maps will be made. 
 
9.2.2 Plastic concentration maps 
To establish these maps, it is necessary to have previously run the current model 
(and possibly the wave model) in the typical situations identified in the previous 
paragraph in order to calculate currents over a period of a few days (5 to 6 in 
general). The Opendrift module will then be used to determine the trajectories of 
the plastics using these current calculations. The other data to integrate is the 
description of the plastic sources in the model: location and quantity of plastic. 
 
If we wish to carry out a realistic calculation, it is then necessary to know the 
flows of plastics entering the sea by the various rivers, these results are provided 
by the SWAT model, treated by LABOCEA in another document. The sources of 
plastics are then initialised according to the SWAT results. It is also possible to 
carry out a theoretical calculation which consists in implementing plastic 
particles on the whole calculation domain, it allows to identify the zones where 
plastics have the most chance to accumulate. 
 
The simplest representation is the "scatter plot", where a point appears on the 
map at each position of a particle at the end of the calculation. Examples of such 
distribution maps are shown in Figure 34 for the Plymouth area. 
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Figure 34 : Example of concentration maps by scenario on Plymouth: living water scenario and east 
wind on top, dead water scenario without wind on bottom. The red dots represent particles still at 
sea, the pictograms represent stranded particles. 

 
9.3 Operational mode  

In this mode of use, the calculation is made for a future situation (forecast) and 
not on a typical schematic situation as in the previous paragraph. 
This requires current (and possibly wave) forecasts for the next few days. Such 
forecasts can be obtained from national and/or European organisations. For 
example, Actimar has used data from the CMEMS "Atlantic - European North 
West Shelf" for calculations in the Channel. This data can be accessed at 
https://data.marine.copernicus.eu/product/NORTHWESTSHELF_ANALYSIS_FO
RECAST_PHY_004_013/description  

https://data.marine.copernicus.eu/product/NORTHWESTSHELF_ANALYSIS_FORECAST_PHY_004_013/description
https://data.marine.copernicus.eu/product/NORTHWESTSHELF_ANALYSIS_FORECAST_PHY_004_013/description
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The representation of the plastics is the same as for the previous calculation 
mode, after an Opendrift calculation integrating the current (and possibly wave) 
forecasts.  A realistic forecast would also imply that the SWAT module is running 
at the same time and that its forecasts directly feed the plastic sources in 
Opendrift. This mode of operation has not been tested, the current mode of 
operation is to define theoretical plastic sources (in rivers or elsewhere) and to 
enter fictitious quantities of plastic particles "by hand". 
 

10 Platform for launching calculations and presenting results 
 
The tools presented in the methodology outlined in this document are relatively 
cumbersome to set up and require specialised skills in oceanography and 
computer science. This methodology will therefore be difficult to reproduce by 
non-specialists, which is why we present here a simple way of accessing and 
using the tools already in place. 
In the framework of the PPP project, this methodology has been applied in 6 
areas. The first 4 areas correspond to 4 of the catchment areas concerned by the 
project: 

- Rade de Brest 
- Bay of Douarnenez 
- Bay of Veys 
- Plymouth 

Two additional areas were covered: 
- The Iroise Sea (at the tip of Brittany, this is an area that includes the Bay of 

Douarnenez and the Bay of Brest) 
- The Channel, this area covers all the catchment areas of the project 

 
The results of these models can be consulted on a dedicated online platform, 
accessible via the following address: 
https://ppp.actimar.fr/ppp/presentation  
 
On this page, the "maps" tab on the left-hand side displays the 6 areas studied. 
The map that appears allows you to choose the area to be consulted. Clicking on 
the chosen area offers different possibilities for guests and for logged-in users: 

- A guest user will simply be able to consult a set of pre-recorded simulations, 
corresponding to the typical scenarios of each zone, the construction of 
which was presented in §9.2.1. 

- The logged-in user will also have the possibility to create his own new 
simulation, by choosing the meteorological-oceanic scenario he wishes to 
use and by manually adding plastic sources to his simulation. 

 
Project partners can request an account. 
 

https://ppp.actimar.fr/ppp/presentation
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